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Ten  golden rules for improving IT users’ competence 

 

1. Organise training at the same time as the system is installed.  

2. Provide users with detailed documentation during training.  

3. Train users so that they understand IT concepts.  

4. Train users so that they understand the usefulness of the IT.  

5. Train users so that they can learn on their own.  

6. Provide a variety of learning material.  

7. Identify, organise, authorise and cultivate superusers. 

8. Include IT, information and use competence. 

9. Provide a variety of support channels and frequency. 

10. Train local groups of users, not only individuals. 
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Chapter 1. Introduction 

1.1. Motivation and target groups 

1.2. Aims 

1.3. Related areas 
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Part I. Activities for learning IT 
The learning aim of Part I is:  

To be able to train IT users so that the users can apply their competence learnt at a course 
when they return to work or other activities. 

The chapters in this part will present approaches for teaching the use of IT. These approaches 
will constitute the structure which the topics of Part II will feed into. 

Part I will take on a training view of developing IT user competence. This means that we 
consider the development of IT user competence which takes place in some training activity, 
and thereafter the competence learnt is transferred to the tasks to be utilised. This could be in 
a work place or in an educational setting or for leisure.  

Seen from the training perspective, learners have some competence when starting up, and 
hopefully a bit more when completing. This new competence is what the learners will bring 
back to the tasks. We can illustrate the process as in Figure 1. 

This sequence may give the impression that new competence learnt during a training course is 
used automatically in the later tasks. However, transfer of competence from one setting to 
another will only take place when the settings are similar, and a course setting will often differ 
a lot from the tasks to be carried out afterwards. Therefore, often only a small part of the 

TrainingTasks

IT competence
when training

starts

IT competence
at the end of

training

Tasks in which the acquired IT competence is used

Transfer

Figure 1. A transfer model of training. Competence is learnt in a course and transferred to work or 
other settings. 
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acquired competence from a training course is actually transferred and be put into play.  

Timing of training is possibly the most important factor to succeed transfer. If training is 
provided weeks before the IT system is put into operation, the users will forget much of their 
new competence, so the possibility for transfer has decreased seriously. On the other hand, if 
training is provided long after a new system is installed, the users may say  

Why training this late? The system has been up for ages, but nobody knows how to use it. The 
management is not giving appropriate attention to this change. 

Users will bring this negative attitude to the training session and blame the trainer for the 
delay and mismanagement. Less motivation for learning and a bad atmosphere will impact the 
course.  

The first golden rule for user learning is therefore: 

The trainer needs to identify the start and ending level of competence for the training. 
Determining the beginning level serves two purposes. The trainer will know where to start, 
and also, the trainer can relate new topics to what the learners are familiar with already.   

Part I will in particular address the issue of transfer. We will describe two types of teaching, 
each of them having particular qualities concerning transfer of the learning outcome. The last 
chapter of Part I will consider evaluation of training, also related to the transfer issue.  

1. Organise training at the same time as the system is installed. 
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Chapter 2. Training for transfer of 
subject matter competence 

The learning aim of this chapter is to be able to design a training session which maximises the 
possibility of the learners for transferring of the competence they acquired into where they 
will use it.   

First, a common training method, which does not support transfer well, is presented. 
Thereafter, this method is contrasted to a way of training which makes transfer more likely to 
happen.  

2.1. Repeat-after-me training  
User training is most likely to be carried out as followed. Each student has a computer, and 
the teacher uses a video projector. For each topic, the teacher first demonstrates how to carry 
out a task at the computer. The teacher tells what keys to pushes on the computer, and its 
screen image is being projected onto the wall. The learners try to remember the keys and 
repeat the operations being carried out. The teacher then hands out some exercises supposed 
to exemplify the topic and the students try to remember what the teacher actually did when 
they do the exercises on their own. Often they have forgotten, so the teacher has to run 
between the desks to help out. After a while, some learners have long completed while others 
are still confused, waiting for the teacher.  

Since the learners try to mimic the teacher, this way of training can be called the parrot style. 
After many hours of training, the learners might have developed sophisticated skills repeating 
what happens on a big screen.  

Comparing this training setting with the user’s work, there are two obvious differences. First, 
there is no teacher with a projector at the work place, and also, there is no teacher running 
between the desks helping out with forgotten details. Instead, the users may face the challenge 
of working on their own most of the time, with the aid of tooltips and an online manual and a 
helpful colleague understanding more of the system to be used.  

Demonstrating software on a projector may provide useful motivation for the functionality of 
a software package, but a pure demonstration does not include the audience trying to do the 
same operations on their computers. Therefore, demonstrations should not be confused with 
parrot training.  

Also, demonstrating computer operations by means of a video controlled by the user also 
differs from the parrot style in two important ways. First, the video can be brought to the tasks 
where the IT is going to be used. This will differ a lot from having to wait for the teacher to 
come along. Second, the user can stop, start and replay the video so it is possible to follow in 
a speed that allows repeating after the video instructions. Videos for repeat-after-me therefore 



 

9 

21. februar 2011 

avoid the pitfalls which make parrot training unsuitable for transfer. We will therefore return 
to video productions in Chapter 9.  

2.2. Conceptual-practical training  
The alternative to repeat-after-me training is a sequence of instructional events which aims for 
meeting a variety of conditions for learning. These sequences also address transfer 
specifically. Based on research on teaching and learning, Gagné and Briggs (1974) proposed a 
nine step model which in general would be the best design of a training session, see Table 1. 

Table 1. Gagné-Briggs sequence of instructional events. 

Instructional event Purpose for the learner 
1. Gain attention Focus on trainer 

2. Inform the learner of the objective 
Focus on the learning goal and the usefulness of 
this goal 

3. Stimulate recall of prerequisite 
competence 

Retrieve prior learning 

4. Present material Perceive essential elements 

5. Provide guidance to the learner 
Perceive how the elements can be 
operationalised 

6. Elicit performance Develop basic skills through own actions 

7. Provide feedback 
Reinforce adequate behaviour and correct the 
inadequate 

8. Assess performance Rehearsals for enhancing skills 

9. Enhance retention and transfer 
Combine usefulness, essential elements, and 
skills 

Although this sequence is designed to be generally optimal, the actual subject to be learnt, the 
learners and the setting, may call for different events and sequences. Concerning IT user 
training, the only instance of instructional development documented is found in (Herskin, 
2006). Although Herskin’s book does not provide references, the sequence of instruction 
presented follows the Gagné-Briggs model.  

Herskin’s model has not been scientifically tested, but based on learners’ feedback. The book 
claims that this sequence improves understanding of the IT concepts, compared to the repeat-
after-me training model. Understanding concepts and principles is known to enhance transfer 
of competence from courses to work (Bransford, 2000, p. 9). The benefit of conceptual 
knowledge for transfer has also been demonstrated in research on computer training (Yi & 
Davis, 2003). This is an additional argument for adopting the Gagné-Briggs model for 
training of IT use.  

The model separates five different types of capabilities, intellectual skill, cognitive strategy, 
information, attitude and motor skill. Correspondingly it shows us five different types of each 
of the nine instructional events. Cognitive strategy concerns problem solving, and this will be 
addressed in Chapter 8.  
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Use of IT tools requires some motor skills like typing on qwerty keyboards and mobile 
phones, hand-eye coordination, changing toners in printers, as well as specialised skills for 
other input or output devices. This book will not address motor skills. Use of IT is primarily 
an intellectual skill. Therefore the sequence of instruction presented in this chapter will 
mainly be built out from this. Also the attitude towards the information technology is 
important for the ability to transfer intellectual skills from courses to work. This will be 
included specifically in events no 2 and 9.  

Information capacity in Gagné-Briggs’s sense concerns the learning of facts. Knowing some 
of these is also useful for transfer. The learning of simple facts will be included in the skills 
practice in event no 6. Information competence, in the sense of the ability to interpret and 
present information, will be considered in Chapter 6. Beware that this is rather a refinement of 
intellectual skills than information capability.  

Table 2 shows a sequence of instructions for teaching one IT topic to a class. The sequence 
should last 30-60 minutes, and the practicals, events 6-8, should make up for at least half of 
the time. Event 1 necessarily comes first, and event 5 links the theory to the hands-on activity. 
Therefore this should be the last event in the introduction. The contents of events 2-4 may 
change order, depending on the teaching topic. Event 6 introduces the practical training, while 
the invocation of events 7 and 8 is determined by the individual or small group initiative and 
progress.  

Table 2. Conceptual-practical training for IT users. Coding: C – concept, U – usefulness, S – skills. 

 Instructional event Teaching use of IT Example – Import by link 
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n.

 P
re

se
nt

at
io

n 
an

d 
di

sc
us

si
on

 
w

ith
 th

e 
w

ho
le

 c
la

ss
 

1. Gain 
attention 

Any quick action which 
draws the learners’ 
attention to the teacher. 
Not necessarily IT 
related. 

Clapping hands. 

2. Inform the 
learner of the 
objective 

C1. Explain the IT 
concept / idea / 
principle to be learnt.  
U1. Explain the 
usefulness of this idea 
for the tasks in which 
the IT is going to be 
used.  

C1. Explain import spreadsheet by 
link into a document. Explain that 
when data needs to be changed, 
updating the spreadsheet is enough, 
inconsistencies are avoided.  
U1. Present an example where a 
report under preparation contains a 
table of figures and calculations, and 
that the figures are not complete yet.  
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 Instructional event Teaching use of IT Example – Import by link 

3. Stimulate 
recall of 
prerequisite 
competence 

C2. Compare the new 
IT idea / principle / 
concept with previous 
ones. 
C3.  Compare also with 
experience from 
phenomena outside IT. 

C2. Present how import by link 
differs from copy and paste, how it 
is similar to hyperlinks, and  
C3. How it differs from the copier 
machine, and ask learners for other 
comparisons. 

4. Present 
material 

C4. Explain the 
principles of how the 
data is stored and 
processed by the 
computer 

C4. Explain how import by link is 
stored in the hard disk. 

5. Provide 
guidance to 
the learner 

C5. Present steps with 
observable results in the 
procedure for carrying 
out the operation.   

C5. Present the steps in the 
procedure for importing by link.  

Pr
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6. Elicit 
performance 

S1. Develop basic skills 
through own actions 

S1. Give the learners an instruction 
sheet with the detailed prescription 
of how to carry out the operation on 
the computer.  

7. Provide 
feedback 

S2. Guide learners who 
face problems and 
confirm correct results 

S2. Guide learners who cannot 
follow the instructions. Confirm 
correct results. 

8. Assess 
performance 

S3. Observe learners’ 
progress of task. 
C6. Elicit their 
understanding by 
asking about the state of 
their data.  
S4. Ask them to repeat 
if necessary, possibly 
with small variations.  

S3. Check whether the learners have 
identified the data and created a link.  
C6. Ask about where the data is 
located and which links they have 
created.  
S4. Ask them to repeat the operation 
if not carried out correctly 
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 Instructional event Teaching use of IT Example – Import by link 
Su
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y.

 D
is

cu
ss

io
n 

w
ith

 th
e 

w
ho

le
 c
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9. Enhance 
retention and 
transfer 

Repeat and extend  
S5. skills, 
C7. data storage and 
processing, and 
C8. Concepts. 
C9. Combine the IT 
concepts with similar 
ideas / principles / 
concepts.  
U2. Repeat the 
usefulness with 
reference to tasks. 

S5. Repeat the steps in the procedure 
and ask about other ways of doing it.  
C7. Repeat how the data is organised 
in the hard disk, and ask about how 
this can be observed.  
C8. Repeat that import by link is 
similar to hyperlinks, and  
C9. Introduce the principle of 
functional dependency as a more 
general concept. Ask for other 
instances of this concept.  
U2. Repeat that inconsistencies can 
be avoided and ask about work tasks 
where this may be advantageous  

Compared to the Gagné-Briggs model, the IT training requires the attention of more elements 
in the events. Understanding the usefulness is an important motivator for learning. This is 
introduced in event 2 as U1 and repeated in event 9, see U2. Likewise, understanding the IT 
concept is essential and often non-trivial. Therefore this is treated nine times in six of the 
events. Teaching for learning skills is the third type of element here, S1 – S5, mainly 
addressed in the middle section, the hands-on part. The distinction between skills and 
understanding will be discussed in Part II.  

Understanding the usefulness and the concept, increases the chances of transferring 
competence from course to work. The clue for transfer of skills lies in the instruction sheet in 
event 6. Based on Herskin’s (2006) suggestion, an instruction sheet is a detailed prescription 
for what menu items to select and buttons to push, in order to bring out the operation being 
outlined in event 5. These instructions must be tailored to particular software brands and 
versions, since the learners have to use this during the practical part.  

The instruction sheets serve two purposes which support transfer. First, during the hands-on 
part, the learners follow the instructions on the sheet, and the teacher does not display the 
software operation on the projector. The learners become accustomed to following a written 
instruction instead of repeating the teacher. Concerning transfer, the latter might be a 
dysfunctional habit, as discussed in Repeat-after-me training section. Second, the learners will 
bring the instruction sheets back to their workplace, and be able to operate the software in the 
same setting at work as in the course.  

Training material for the example indicated in the rightmost column of Table 2 will be spelled 
out in the sequel. The material is annotated by double encircled codes U1, etc., in order to 
show which element in the instruction sequence the material is targeting. 

. 
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Importing spread sheet into document

• Aim
– Able to choose copy-paste or import by link

• Problem
– You are to write a report on the health for last year

• The numbers are not complete yet
• You have to start writing nevertheless

– Numbers in a table in a spread sheet
– Table should be part of a document
– What happens if data in the table needs to be changed?

1

U1

 

Figure 2. First slide for learning import by link. Emphasis on usefulness. 

This introduction opens with presenting a case for which the operation can be useful, U1.  

Copy-Paste
• Two copies of the table on the hard disk
• Changes in spread sheet NOT propagated to document

2

Copy - Paste

C2

 

Figure 3. Repeating known principle. Illustrating the hidden data on the hard disk. 

Instead of presenting the new concept first, this introduction starts out with what may go 
wrong with the operation already known by the learners. It also illustrates the relation 
between what is shown on the screen and the how the data is stored on the hard disk, see 
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Figure 3. The essence in this case is understanding how a new concept relates to one which is 
previously known, the copy-paste. The results of both operations look the same on the screen, 
but how it is stored on the hard disk differs. For supporting this understanding of hidden data 
structures, the relation to the visible is illustrated in Figure 4. Chapter 9 will provide guidance 
to the design of such kinds of illustrations.  

In order to provide a concrete illustration of importing by a link, the teacher could present the 
dynamics that the link offers. The teacher could display an already prepared solution on a 
projector, and demonstrate that when changing a number in the spread sheet, the document is 
changed accordingly. The point of this demonstration is to show the benefits of the result; not 
to learn how to do it. The ‘how-to’ is for the practical part, to avoid the repeat-after-me style; 
the learners are not try to try repeating what is done, therefore the teacher is not to tell which 
buttons to push.  

Import by link
• One table on the hard disk
• Link
• Changes in spread sheet propagated to the document

3

Import by 
link

C1
C2

C4

 

Figure 4. The way import by link is stored in the hard disk.  
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Procedures

Copy-paste
1. Open both files
2. Copy the table and paste

it into the document
3. Check by changing the

spreadsheet

Import by link
1. Open both files
2. Insert the table into the

document such that the link to 
the spreadsheet is kept

3. Check by changing the
spreadsheet

4

C5

 

Figure 5. The procedure for the operations at the computer. 

The procedure for carrying out the operations is divided into three steps (Figure 5). The 
separation follows the fixed rule that after a step, the learner may observe on the computer 
whether it has been successfully carried out. This will ensure the learner if being on the right 
track. If not, asking the teacher may be appropriate.  

After the copy operation, the computer does not provide observable feedback about what has 
been copied. That is why copying alone does not constitute any step in the procedure.  

In event 6, instruction sheets for OpenOffice (Figure 6) or Word (Figure 7) are handed out to 
the users, out from what software they are using. The sheets are tailored to their level, to 
assume that they are able to manage the normal menu operations. The specifics of the 
operation taught is illustrated in detail. The learners are supposed to follow the instructions 
without any oral teaching or projector guiding. With the level of details in these instruction 
sheets, most learners can do that.  

When learners work on their own, the teacher can move around freely in the classroom to help 
out when needed. Experience shows that working with instruction sheets relieves the teacher 
from most of the requests that appear during hands-on training in the repeat-after-me style. 
The teacher is gaining time to respond to the questions from the learners. In the repeat-after-
me training, time for responding becomes too short.  

During introduction and summary, instructions for particular software installations are 
avoided in all written materials and presentations. There are three reasons. First, the 
introduction and summary should focus on understanding. Second, the strict separation allows 
learners using different versions of software to be taught, as long as the teacher has instruction 
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sheets for all versions. Third, a modularised design of training material is achieved. When a 
new software version appears, the material for introduction and summary can be kept 
untouched.  

Figure 6. Instruction sheet for hands-on practice with OpenOffice. 

Instruction sheet 

Table into document with OpenOffice Writer 

Copy-paste 
1. Open the file AnnualReport and the file RiversideData. 

2. In RiversideData, mark the table you want to copy and select Edit → Copy .  
In AnnualReport, click where you want the table to appear, and then select Edit → Paste 

3. In RiversideData, change Headcount for July to 503. Did it change in AnnualReport? 

Import by link 
1. Open the file AnnualReport. 

2. Click where you want the table to appear, and then select Insert → Object → OLE Object 
Fill the dialogue box as follows.  

 

3. Open RiversideData, change Nurse clinical work days for August to 43 and Save 
RiversideData. 
In AnnualReport, select Tools → Update → Update → Open Read Only.  

Did it change in AnnualReport? 
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Although the written material for the summary is without the technical details, asking the 
learners in the beginning of the summary about their practical experience serves two 
purposes. First, it is an opportunity to discuss other ways of carrying out the operation, for 
example by means of shortcuts. This might be a help for the whole class to pick up some 
details. Second, it forces the learners to talk about what they have done. Making experience 
explicit is a step towards understanding.  

The slides for the summary focus on three topics. The concept of import by link, how this 

  Figure 7. Instruction sheet for hands-on practice with Word 2007. 
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concept is a special type of a more general type, and its usefulness.  

Two ways

5

Inconsistencies when 
updating the spread sheet

Inconsistencies avoided

C7

C8
 

Figure 9. Repeating the difference between copy-paste and import by link in the summary. 

The distinction between the concept of this session and the old one (copy-paste) is still 
emphasized, see Figure 8.  

Then the topic is taken to a more abstract level. Import by link is compared to formulas in 
spreadsheets supposed to be known to the learners. Both are illustrated as examples of the 
functional dependency principle, Figure 9. Understanding similarities and more general 
concepts ease the learning of new concepts, which is why we should aim at more general 
understanding. These issues will be discussed thoroughly in the chapters “Competencies and 
learning” and “IT concepts.” 
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Functional dependency
– Import by link

Changes in spreadsheet changes in document

– Table of contents
Pages inserted Table of contents updated

– Formulas in spreadsheet
Arguments changed Result updated

• Link from display to data storage
– Data changed Changes propagated to display

6

cOther 
examples?

C9

 

Figure 10. How import by link is a special instance of the functional dependency principle. 

In order to improve the likelihood of transfer, tying the learnt concept to the users’ future 
practice is repeated. Therefore, asking the learners about where import by link can be useful 
or disadvantageous concludes the summary, see Figure 10.   

Other use?

7

cWhen do we 
choose Copy-
Paste anyhow?

c Are there other types of data 
than tables where import by 
link is an advantage?

U2

 

Figure 11. Last slide in summary, triggering discussion about usefulness.  
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2.3. Learner activity 
The Conceptual-practical training model mainly addresses the contents of the session and the 
role of the teacher. Also the learners’ activity is important for transfer, so we will point to 
ways to organise this.  

During the introduction, making the learners to talk about cases where they have added spread 
sheet tables in documents, serve two purposes. First, it triggers the learners’ attention to the 
current topic, and second, it informs the teacher about the learners’ competence in this area 
and thus how to address the explanations.  

During the practical, obviously the learners are busy on their computers. This is necessary for 
developing the initial skill. Since talking while doing contributes to understanding, it might be 
better if the learners were discussing while running the computer. This can be achieved 
through having two learners at each computer. One is operating the keyboard and mouse, 
while the other is making comments, asking questions, checking the documentation etc. Then 
the pair swap roles, so that both do the hands-on exercise. A laboratory study showed that 
learners operating in pairs outperformed individuals in their conceptual understanding. The 
pairs could explain more about how the software operated and they performed better in 
exercises which introduced some novel elements (Lim, Ward, & Benbasat, 1997).  

Operation in pairs is known from computer science education as ‘pair programming.’ Several 
studies have been carried out, and pair programming has been proved more effective for 
bringing more students through exams than the individual programming (McDowell, Werner, 
Bullock, & Fernald, 2006). The lesson from learning of programming addresses learning 
goals of understanding and problem solving. 

Motor skills were not considered, neither in the user learning nor the computer science cases. 
It would be reasonable to believe that learners, still struggling with the mouse and keyboard, 
should be practicing this as much as possible, while pair learning fits better for those above 
this level.  

2.4. Summary 
The Conceptual-practical training model emphasizes three important issues for transfer. These 
will be summarised as three Golden rules for user learning: 

Exercises 
1. Extend the case on import by link with two more exercises for the practice training, so 

that those who complete quickly can move on to the next one. Each of the additional 
exercises includes a small, new challenge. 

2. Provide users with detailed documentation during training. 

3. Train users so that they understand IT concepts. 

4. Train users so that they understand the usefulness of the IT 
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2. Extend the case on import by link with two more examples for illustrating the 
usefulness of the concept.  

3. Find two or three examples for usefulness of the topic to be included in a Conceptual-
practical training for the following subjects: 

a.  Table of contents in a document, 
b.  Line graphs in spread sheets,  
c. URLs as displayed in hits from search engines. 

4. Write explanations and make a drawing of  
a. Saving and finding files 
b. Cross references 
c. Playlists in music players 

Make sure that the explanation and drawing fit into one slide. 
5. For the cases in the two exercises above,  

a. Identify an example from the world outside the computer which resembles the 
computer concept. 

b. What is the similarity? 
c. How does the computer concept differ? 
d. Express the similarity and difference on one slide, including a drawing. 

6. The following slides are intended to cover the introduction part of a training session on 
indexes in documents, steps 1-5 in the Conceptual-practical training for IT users. 
Assess this introduction according to the principles presented in this chapter.  

INDEX CREATION
PRERIQUISITE KNOWLEDGE 

– Familiarity with Microsoft Word Processor
a) Main menu
b) Tool bar
– Ability to navigate through a word document

OBJECTIVES
By the end of the lesson, learners should be able to;

• Mark index entries
• Create an index

1
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• An index is a directory arranged 
alphabetically to guide on the location 
of key words or phrases in the 
document.

• Key words are core items that 
surrounds and best explain the main 
topic

Definitions

2

 

 

Mark index entries

• Highlight the key word or phrase then,
- On the menu bar, go to “Reference” then  

“Mark entry” and on the other window “Mark”

- Click where you want your index to appear.

3
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Create an index
• After all entries have been marked, then go to “Index 

group icon” and click “Insert index”

• This window will show, then do
– Check Right align page numbers
– Tab leader (select one)
– Formats (select one)
– Select type, Columns and   
– Language

– Accept all by clicking “OK” 4

 

7. Construct an instruction sheet and example files which are appropriate for hands-on 
training of  

a. Table of contents  
b. Inserting pictures into documents 
c. Line graphs 

8. Find other concepts/principles/ideas in the computer which are similar to 
a. Cross references 
b. Properties of a file in the file system 
c. Master slides 

For each of these cases, to which other general principles from computers 
would you relate them? Out of the possible ones, which principle would you 
use for explaining to users? 

9. Design a first version of a Conceptual-practical training for learning  
a. Table of contents in a document 
b. Pivot tables in spreadsheets  
c. Download and install an application on a mobile phone. 

10. Of from your experience, which computer topics do your friends, family or colleagues 
struggle to learn? 

a. What is difficult learning these topics?  
b. Does the difficulty concern usefulness, concept or skills? 

Project 
Design a first version of a Conceptual-practical training for learning one of the topics 
identified in the previous exercise. 
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Chapter 3. Evaluation of training 

The learning aim of this chapter is to be able to design appropriate evaluations of training. 

3.1. Evaluation of reaction to training  

3.2. Evaluation of learning – assessing competence  

3.3. Evaluation of behavioural change  

3.4. Evaluation of result or outcome  
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Pedagogical theory – behaviourism 
Within a training and transfer view of user competence, the outcome of the learning 
process which takes place during training is our focus. This view of learning is in 
accordance with the behaviourist approach, where learning is considered a relatively 
stable change of the potential for action. That means, after learning, the learners should be 
able to do things which they could not do before, and that this ability is not a random 
change. Being able to do something does not necessarily imply that it is done, since 
required conditions like time and money might not be present. The behaviourists only 
consider observable behaviour, meaning that what goes on in people’s head is outside the 
area of interest.  

The typical way of regarding learning in the behaviourist perspective is that a person is 
presented with a stimulus from the environment, for example Arja’s computer displaying a 
spread sheet table and a document.  Thereafter Arja responds to the stimulus, for instance 
by importing by a link. If this response was different from the previous ones, and also that 
Arja continues with this response more times when she is presented with the same 
stimulus, she has learnt a new behaviour.  

After a response, the person can receive a new stimulus, which can reinforce the learning, 
for example that the numbers in the document are updated according to changes in the 
spread sheet. If seeing this makes her more inclined to import by link the next time she 
sees a spread sheet table and a document, then the updating constitutes a reinforcement for 
her learning. 

Positive reinforcement like appraisals and negative reinforcements like the disappearance 
of an error message will both strengthen learning. Immediate reinforcements are better 
than delayed ones, and informative better than uninformative ones. For example, 
observing the change of numbers is an informative reinforcement. Repeated 
reinforcements at variable intervals are also more effective than only one reinforcement or 
repetitions at regular intervals.  

Punishments weakens learning and are the opposite of reinforcements. For instance, after 
printing a file, the computer displays the message Illegal user action! 
Printer damaged! would for most users constitute a punishment, making them less 
likely to try the print command again. Also, lack of any new stimulus after response 
weakens learning, for example that the computer does not provide any feedback after the 
user issues a print command.  
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